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警告 

1. 禁止用户自行拆卸模块元器件。 

2. 请用户自行检查模块供电电压是否符合使用手册中不同选型的供电电压要求。 
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公司简介 

沈阳中科博微科技股份有限公司是由中国科学院沈阳自动化研究所发起创建的一家高新

技术企业，主要从事网络化控制系统、工业通信及仪表、开发、生产和应用。中科博微承担了

多个国家科技重大专项、国家高技术研究发展计划（863 计划）、智能制造装备发展专项等国

家科技计划项目，是国家网络化控制系统工程研究中心建设依托单位。 

中科博微成功地开发了国内第一个通过国际认证的现场总线协议主栈、第一个通过国家认

证的现场总线仪表、国内第一个通过德国 TüV 认证的安全仪表，与其它单位共同主持了制定

国内第一个工业以太网协议标准 EPA、第一个工业无线通信协议标准 WIA-PA，并成为 IEC

国际标准。 

中科博微的产品和技术曾荣获国家科技进步二等奖两项、国家科技发明奖一项、中国科学

院科技进步一等奖一项、辽宁省科技进步一等奖一项，产品出口欧美等发达国家，美国

Emerson、英国 Rotork、英国 Bifold 等业内顶尖企业都在其产品中采用了博微的关键技术或

关键部件，成功完成了 200 多项大型自动化工程项目。 

中科博微是 FCG 组织成员；是 Profibus 用户组织（PNO）成员。 

中科博微成功通过了 ISO9001:2008 质量管理体系认证和汽车行业的 ISO/TS16949 质量

体系认证。优秀的研发团队，丰富的自动化工程设计与实施经验，业界领先的产品，庞大的市

场网络，优秀的企业文化，都为公司的创业和持续发展奠定了坚实基础。 

承载员工理想，创造客户价值，促进企业发展。 
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第1章 概述 

M0306 Modbus 转 DP 嵌入式模块是沈阳中科博微科技股份有限公司研发的 Microcyber M 系列嵌入式

模块之一，此系列嵌入式模块具有同尺寸、同接口、易升级、配置简单等特点，是用户快速开发现场总线

设备的理想选择。 

将 M0306 嵌入到具有 Modbus RTU 通信能力的用户板中，即可实现用户设备到 PROFIBUS DP 从站

设备的转变。 

替换成 M 系列其他模块，即可快速实现 PROFIBUS PA、FF、HART 等现场总线设备。 

根据 MCU 端供电电压及用户接口 2 接插件的有无，本产品可分为四种选型。M0306 Modbus 转 DP 嵌

入式模块如下图 1.1 所示： 

 
图 1.1 M0306 Modbus 转 DP 嵌入式模块 

1.1 模块特点 

1) 开发周期短：用户不需要了解 PROFIBUS 开发技术，不需要购买 PROFIBUS 开发系统，也不需要自

己编写 GSD 文件，就可在短时间内完成开发具有自主知识产权的 PROFIBUS 产品； 

2) 同尺寸：Microcyber M 系列嵌入式模块尺寸相同，65mm（长）*42mm（宽）； 

3) 同接口：Microcyber M 系列嵌入式模块均采用 2.54 间距 16 针接插件，功能兼容； 

4) 易升级：替换 Microcyber M 系列不同的嵌入式模块，即可实现不同协议的设备； 

5) 配置灵活：通过配套的 Modbus 通用配置工具用户可以根据需要自由灵活地对模块进行各种参数设置； 

6) 应用简单：通信模块通过串行接口读写用户产品的 MCU 输入输出数据，并自动将其转换成 PROFIBUS 

DP 协议数据与 PROFIBUS 主站进行通信； 

7) 应用广泛：可广泛用于各种产品，如：变频器、电机启动保护装置、智能高低压电器、电量测量装置、

各种变送器、智能现场测量设备及仪表等等； 

8) 以 OEM 方式提供：用户对产品有自主知识产权、品牌和商标注册权。 
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1.2 产品开发工作流程 

 

 

第二步：软件设计 

软件除了跟模块的接口定义需要修改之外，其余原有软件设计均无需改动。模块与用户产品之间

采用 ModbusRTU 协议通信。 

第三步：模块配置 

根据用户需求，使用 Modbus 通用配置工具对模块进行必要的出厂配置。 

第四步：串口通信 

初步调试检查用户板与模块接口的串口数据通信是否正常。 
 

第五步：修改 GSD 文件 

使用 Modbus 通用配置工具，通过修改关键参数，将示例 GSD 文件修改成用户产品 GSD 文件。 

 

第六步：安装、配置、调试产品 

建议使用西门子设备搭建一个调试实验系统，用于检测 PROFIBUS 通信，以及产品运行。使用实

验系统连接用户开发的产品，调试实现设计功能。 

结束 

第一步：硬件设计 

根据本模块外形尺寸、接口管脚定义，将用户产品硬件原理图、PCB 图重新设计。如考虑 M 系列全兼

容，则需要参考所有 M 系列模块的接口管脚定义再进行硬件设计。 
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1.3 外形尺寸 

 
图 1.2 外型尺寸（单位：mm） 

1.4 模块结构 

1

3

4

2

5

 
图 1.3 模块结构 

1 拨码开关（S1） 2 用户接口 2（J1） 3 Modbus 通信指示（LED2） 

4 用户接口 1（J4） 5 DP 通信指示（LED1）   
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第2章 安装 

2.1 模块对外接口 

2.1.1 用户接口 1（J4）管脚定义及说明 

用户接口提供给模块一路信号隔离直流电源。还提供了两卡之间的串行接口，以及指示灯等功能，具

体描述见下表 2.1。 
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图 2.1 用户接口管脚定义及外型尺寸 

如图 2.1 所示，用户接口 1 采用 16 针接插件，具体管脚定义如下： 

表 2.1 用户接口管脚定义 

管脚 I/O 说明 管脚 I/O 说明 

1 I VCC（5.0V / 3.3V 直流电源） 2 O VCC 地 

3 I CPU 复位：低有效 4 I/O 保留 

5 O CPU 串行数据发送 6 I/O 保留 

7 I/O 保留 8 I CPU 串行数据接收 

9 O 接 PROFIBUS DP  D 型插头第 4 引脚 10 O DP 通信状态指示 

11 I/O 接 PROFIBUS DP  D 型插头第 3 引脚 12 I/O 接 PROFIBUS DP  D 型插头第 8 引脚 

13 I/O 保留 14 I/O 保留 

15 I 5V 隔离电源 16 O 0V（隔离电源地，与 GND 隔离） 
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2.1.2 拨码开关（S1） 

拨码开关包含 PROFIBUS DP 从站地址设置及工作模式选择功能。 

1 2 3 4 5 6 7 8

ON

 
图 2.2 拨码开关 S1 

表 2.2 拨码开关 S1 功能描述 

序号 名称 说明 

1 1 如果为 ON，地址+1，否则，地址+0。 

2 2 如果为 ON，地址+2，否则，地址+0。 

3 4 如果为 ON，地址+4，否则，地址+0。 

4 8 如果为 ON，地址+8，否则，地址+0。 

5 16 如果为 ON，地址+16，否则，地址+0。 

6 32 如果为 ON，地址+32，否则，地址+0。 

7 64 如果为 ON，地址+64，否则，地址+0。 

8 M M0306 工作模式设定，ON 为配置模式，OFF 为正常工作模式。 

2.2 模块安装 

M0306 有三个 Φ3 的定位孔，可使用 3 个高 11mm 的六棱柱固定安装到用户板上。 
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连接方式1：信号来自于用户接口1，D型接头设计在用户板上。

连接方式2：信号来自于用户接口2，D型接头通过软线与M0306模块

用户接口2连接。

 
图 2.3 模块安装 
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第3章 系统环境搭建 

3.1 必备条件 

3.1.1 硬件 

1） 电脑（台式机/笔记本电脑） 

2） CP5611/CP5512 

3） 控制器（CPU315-2DP/其他型号） 

4） 90 度无编程 DP 连接器（3 个） 

5） USB 转串口线（1 条） 

6） 配置底板（1 块） 

3.1.2 软件 

1） Step7 V5.4 或以上版本 

2） Modbus 通用配置工具 

3） Modbus Slave 模拟软件 

3.1.3 待测设备 

1） M0306 嵌入式模块（1 块） 

2） GSD 文件 

3） 设备图标文件 

3.1.4 简要介绍 

1） CP5611 是 PCI 接口卡，用于台式机；CP5512 是 PCMCIA 卡，用于笔记本电脑。这两种卡的功能是

一样的，主要有两个用途：一是给控制器编程，二是给 PROFIBUS 设备进行组态配置； 

2） 控制器用于检测设备循环数据交换功能； 

3） 90 度无编程 DP 连接器是用来组建 PROFIBUSDP 网络的，用于连接插在电脑上的 CP5611/CP5512

和控制器； 

4） DP 设备一般需要外供电，USB 转串口线既可以给配置底板和 M0306 模块供电也可以作为串口通信线

连接电脑与配置底板； 

5） Step 7 软件用于做硬件组态配置，此时要用到 GSD 文件； 

6） Modbus 通用配置工具在模块配置模式下对模块进行参数配置； 

7） Modbus Slave 模拟软件在模块正常工作模式下模拟用户 Modbus RTU 从站设备。 
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3.2 硬件环境搭建 

3.2.1 网络组建 

终端

PROFIBUS

主站

DP 从站

用户板

M0306 

终端

 
图 3.1 模块网络组建图 

1） 如上图 3.1 所示，电脑、控制器以及 M0306 模块配置底板通过 90 度无编程 DP 连接器制作的 DP 总线

连接起来，保证 DP 总线的两端各有一个终端。 

2） 通过 90 度无编程 DP 连接器制作的 DP 总线，如下图 3.2 所示： 

 
图 3.2 DP 连接器接线图 

3.2.2 模块地址设置 

1） 硬件设置地址：在模块断电的情况下通过拨码开关 S1 进行设置，然后模块在正常工作模式下启动

后就可以通过拨码开关 S1.1~S1.7 状态获取 DP 从站地址信息。 

2） 通过串口获取用户设置的地址：在配置模式下启用串口设地址功能并配置串口设地址 Modbus 相

关参数，然后模块在启动正常工作模式后就会根据用户设置的串口设地址参数通过串口获取 DP 设

备地址信息，若没有获取到 DP 地址，则 M0306 模块读取 Flash 内存储的数据作为 DP 地址，之

后可通过 DP 总线设置 DP 地址。 

3） 总线设置地址：当配置为“串口设 DP 地址”后，当模块读取 DP 地址的 Modbus 命令发送完毕后，

在模块不处于数据交换状态时，用户可通过总线设置模块的 DP 地址。 

注意：本实例使用模块默认参数设置，DP 地址采用第一种硬件设置方式，将模块 DP 地址设置为 7，

在实际应用中用户可以根据具体需要选择一种方式进行设置。

R 
on 
off 

R 
on 
off 

接电脑 接控制器 

ON OFF 

接 M 0306 模块 

配置底板 

R 
on 
off ON 
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第4章 系统配置 

4.1 基本工作参数配置 

4.1.1 准备工作 

启动安装有必备软件的电脑，将 M0306 模块通过 J4（16 针接插件）接口安装到配置底板上，将拨码

开关 S1.8 拨到配置模式（ON）状态下，根据模块选型（3.3V 或 5.0V）选择配置底板的供电跳线帽方式，

然后用 USB 数据线将配置底板与电脑连接起来，模块上 LED2 闪烁 3 次后常亮进入参数配置模式，系统连

接如下图 4.1 所示： 

OFF ON

CPU

电脑

ON

通过Micro USB

数据线，将工装

USB接口与电脑

连接

CP5611

 
图 4.1 模块系统连接图 
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4.1.2 参数配置 

M0306 模块的设备参数可由 Modbus 通用配置工具软件进行配置，在配置的过程中，当需要在编辑框

中输入参数时，输入数值后需要点击回车按键，确认输入。 

4.1.2.1 添加设备 

1） 打开电脑上的 Modbus 通用配置工具，界面如下图 4.2 所示： 

 
图 4.2 Modbus 通用配置工具 

2） 根据右侧栏中的操作提示添加串口，弹出端口列表对话框，如下图 4.3 所示： 

 
图 4.3 端口列表 
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3） 选择目标串口，点击 按钮，或在目标串口图标上双击，将串口添加到已选端口栏中，如下图 4.4

所示： 

 
图 4.4 添加串口 

4） 点击“创建”按钮，创建端口，如下图 4.5 所示： 

 
图 4.5 串口添加完成 
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5） 在创建的端口上点击右键，根据操作提示搜索设备，搜索成功会在端口号下方显示搜索到的设备信息，

如下图 4.6 所示： 

 
图 4.6 搜索设备 

4.1.2.2 配置公共参数 

1） 在搜索到的设备“DP”上单击鼠标左键，将上传 M0306 模块当前参数配置信息，如下图 4.7 所示： 

 
图 4.7 上传参数 
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2） 参数上传完毕后可以看到模块当前的参数配置信息，默认显示首页“公共参数”信息，如下图 4.8 所示： 

 
图 4.8 公共参数 

3） 根据需要进行参数配置，然后点击下载当前页参数按钮 进行参数下载，下载成功会有提示信息，如

下图 4.9 所示： 

 
图 4.9 下载在线参数 
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4.1.2.3 配置专属参数 

1) 展开参数列表下拉选项，选择专属参数，如下图 4.10 所示： 

 
图 4.10 选择专属参数表 

2) 点击专属参数表后将显示模块专属参数配置信息，如下图 4.11 所示： 

 
图 4.11 专属参数配置 

a) 输入设备 ID，点击回车确定输入； 

b) 选择串口设 DP 地址是否使能： 

 使能：通过用户配置的 Modbus 命令从用户板获取 DP 地址，并允许通过总线设置 DP 地址；
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选择命令功能码，输入起始地址，回车确认输入值，选择有效字节（用户板保存 DP 地址的

Word 数据高低字节），如下图 4.12 所示： 

 禁止：从模块 S1 拨码开关获取 DP 地址。 

 
图 4.12 串口设 DP 地址 

c) 设置模块与用户板循环输入输出数据通信 Modbus 命令队列，在四组命令的表头上右键，弹出添加

或删除一条命令选项，点击“添加一条命令”将在该组内添加一条 Modbus 命令，在已经添加的命

令行上右键，点击“删除所选命令”将删除该命令，如下图 4.13 所示： 

 
图 4.13 添加一条 Modbus 命令 
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d) 设置 Modbus 命令参数，新添加一条命令后为命令选择功能码，输入起始地址，点击回车确认输入，

输入数量，点击回车确认输入；如下图 4.14 所示： 

 
图 4.14 设置 Modbus 命令参数 

e) 选择 I/O 配置数据的连续性，“单一”或“全部”，如下图 4.15 所示： 

 
图 4.15 I/O 配置数据连续性 

3) 根据需要进行参数配置，然后点击下载当前页参数按钮 进行参数下载。 
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4.1.2.4 配置用户参数 

1) 展开参数列表下拉选项，选择用户参数，如下图 4.16 所示： 

 
图 4.16 选择用户参数表 

2) 点击用户参数后将显示模块用户参数配置信息，如下图 4.17 所示： 

 
图 4.17 用户参数配置 
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3) 若用户启用该项功能，在用户参数命令设置表头上右键，添加或删除一条 Modbus 命令，如下图 4.18

所示： 

 
图 4.18 添加或删除一条命令 

4) 设置 Modbus 命令参数，选择功能码，输入起始地址，点击回车确认输入，输入数量，点击回车确认输

入，输入值（Hex），点击回车确认输入，如下图 4.19 所示： 

 
图 4.19 设置 Modbus 命令参数 
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5) 根据需要进行命令的添加及参数配置，然后点击下载当前页参数按钮 进行参数下载。 

4.1.2.5 下载在线参数 

除了可以在每页参数设置完成后点击下载当前页参数按钮 进行当前页参数下载外，还可以先把每页

的参数设置完成后在主机列表中的 COM10 上右键，选择“下载在线参数”选项，下载所有页参数，如下图

4.20 所示： 

 
图 4.20 下载在线参数 

4.1.2.6 保存配置 

当设置好 M0306 模块工作参数后可以保存一份当前配置文件，这样当给其他一个或多个模块配置相同

参数时就可以加载所需的配置文件。 

1) 点击“文件库”中的“保存”按钮，弹出文件保存对话框，如下图 4.21 所示： 

 
图 4.21 保存文件 

2) 输入文件名，如“XXX”，点击保存按钮，保存文件。 
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4.1.2.7 下载离线参数 

除了上述下载当前页参数和下载在线参数两种方式外还可以选择下载离线参数方式，步骤如下： 

1） 展开“文件库”中“DP”类别中的配置文件，选择一份配置文件，如上文中保存的“XXX”，如下

图 4.22 所示： 

 
图 4.22 选择配置文件 

2） 点击“加载”按钮，加载配置，如下图 4.23 所示： 

 
图 4.23 加载配置文件 
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3） 点击“确定”按钮，文件加载完毕； 

4） 在主机列表中“COM10”上右键，选择“下载离线参数”选项，将刚刚加载的离线参数下载到

“COM10”下的 M0306 模块中，如下图 4.24 所示： 

 
图 4.24 下载离线参数 

4.1.2.8 批量下载 

当需要给多个模块配置相同参数时可以选择批量下载方式，步骤如下： 

1） 将多个要配置的模块通过串口与配置主机连接； 

2） 加载要下载的配置文件； 

3） 点击菜单栏中的批量下载按钮 ，弹出批量下载对话框，如下图 4.25 所示： 

 
图 4.25 批量下载 

4） 点击“确定”按钮，开始批量下载操作，若下载过程中出错会弹出对话框提示错误信息。 

4.1.2.9 恢复出厂设置 

1) 选择目标模块，例如，选择主机列表中“COM10”下的 DP，点击“DP”，如下图 4.26 所示： 
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图 4.26 选择设备 

2) 点击“恢复出厂设置”按钮 ，弹出恢复出厂设置对话框，如下图 4.27 所示： 

 
图 4.27 恢复出厂设置 

3) 点击“确定”按钮，模块恢复出厂设置； 

4) 恢复出厂设置后模块公共参数中的“数据配置标志”参数会被置为出厂无效状态，模块 Flash 存储

的 DP 地址为 125。 

4.1.2.10 生成 GSD 文件 

给 M0306 模块下载完参数后就可以生成对应当前参数配置的“设备 GSD 文件”了，步骤如下：    

1） 选择“参数列表”中的“GSD 文件”选项，进入 GSD 文件操作界面，如下图 4.28 所示： 

 
图 4.28 生成 GSD 文件 

2） 根据需要填写基本信息，点击“生成”按钮，弹出文件保存对话框，输入文件名和路径，保存 GSD

文件。 
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4.1.2.11 打印 

通用配置工具支持模块参数信息打印功能，点击菜单栏中的打印机按钮 ，根据提示选择打印机，

然后点击打印按钮，打印当前设备的参数配置信息。 

4.2 硬件组态 

4.2.1 新建工程文件 

1） 打开 Step7 软件，关闭向导，关闭默认打开的工程。然后再新建一个工程，点击“File New…”，如

下图 4.29 所示： 

 
图 4.29 新建工程 

2） 输入工程名称，例如：“M0306_Test”；Type 缺省为“Project”；选择工程存储路径，例如：“C:\Program 

Files\Siemens\ Step7\s7proj”，点击 OK 按钮。然后根据实际硬件的情况来搭建工程，首先，确定 CPU 

的型号。以 CPU315-2DP 为例，它是属于 SIMATIC300Station，所以选择“Insert→Station→SIMATIC 

300 Station”。在当前工程下，将会出现“SIMATIC 300(1)”，如下图 4.30 所示： 
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图 4.30 添加控制器 

3） 展开 M0306_Test，选择 ，双击“Hardware”图标，打开硬件组态，如下图 4.31 所示： 

 
图 4.31 硬件组态 

4.2.2 添加导轨 

在右侧树形列表中的“SIMATIC300→RACK 300→Rail”上双击添加导轨，如下图 4.32 所示： 
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图 4.32 添加导轨 

4.2.3 添加电源 

如果是非西门子的电源，则不用添加。本文以 PS 307 2A 为例，在右侧树形列表中选中“SIMATIC 

300→PS-300→PS 307 2A”，直接拖拽到“(0) UR”的第 1 栏中，如下图 4.33 所示： 

 
图 4.33 添加电源 
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4.2.4 添加控制器 

1） 根据控制器的实际型号选择添加。例如：在右侧树形列表中选中“SIMATIC 300→CPU-300→CPU 

315-2 DP→6ES7 315-2AF03-0AB0→V1.2”，直接拖拽到“(0) UR”的第 2 栏中，将会弹出一个属性

配置窗口，如下图 4.34 所示： 

 
图 4.34 添加控制器 

2） 设置控制器的 PROFIBUS DP 总线地址为 2，点击“New…”，创建 DP 总线，选择“Network Settings”，

配置总线参数，如下图 4.35 所示： 

 
图 4.35 网络设置 
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3） 配置波特率为 1.5Mbps，其它配置不变，点击 OK 按钮，关闭总线参数配置窗口，再点击 OK 按钮，

关闭属性配置窗口。此时，“(0) UR”导轨上将会出现已选择的控制器，以及与该控制器 DP 端口相连

接的一条 DP 总线。至此，硬件组态基本搭建完成，如下图 4.36 所示： 

 
图 4.36 硬件组态 

4.2.5 加载 GSD 文件 

搭建完硬件组态，还差待测设备的组态。如果是第一次测试该设备，那么需要先加载该设备的 GSD 文

件，本实例使用在 4.1.2.10 中生成的 M0306 模块默认配置 GSD 文件“MCYB0FC5.gsd”，GSD 文件名称

可以由用户定义，具体命名规则参见 M0306 用户手册第五章 GSD 说明部分，这里采用的是本公司名称缩

写加设备 ID 号形式。 

添加 GSD 文件有两种方法： 

1） 手动添加：将设备的 GSD 文件 COPY 至 Step7 安装目录下的 Step7\S7data\gsd\目录下，产品图标

（ *.bmp ）文件  COPY 至 Step7\S7data\nsbmp\ 目录下。在“ HWConfig ”的菜单中选择

“Options→Update Catalog”选项，更新 GSD 文件。 

2） 软件导入： 

a) 在“HW Config”的菜单中选择“Options→ Install GSD File…”选项，将打开导入 GSD 文件窗

口，如下图 4.37 所示： 
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图 4.37 安装 GSD 文件 

b) 点击“Browse…”，选择 GSD 文件所在路径，会罗列出当前路径下的所有 GSD 文件。选择需

要导入的 GSD 文件“MCYB0FC5.gsd”，然后点击“Install”。一直点击“Yes”，直到出现下图

4.38 为止： 

 
图 4.38 安装 GSD 文件成功 

c) 点击 OK 按钮，关闭导入 GSD 文件窗口。刚刚安装的 M0306 设备会出现在硬件组态界面的右侧

树形列表中，如下图 4.39 所示： 



 

~28~ 

 
图 4.39 设备登录 

4.2.6 添加待测设备 

1） 单击左上角 PROFIBUS 上的虚线使其变成实线，拖拽 M0306 到 DP 总线上，会自

动弹出属性窗口。按需要配置从站模块地址，本实例设置地址为 7，如下图 4.40 所示： 

 
图 4.40 从站模块地址设置 
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2） 点击 OK，完成设备的添加，完成后的界面如下图 4.41 所示： 

 
图 4.41 模块组态 

3） 至此，组态就完成了，然后可以保存并编译这些配置，选择菜单项中的“Station→Save and Compile”

选项或者按“Ctrl + S”快捷键进行保存和编译，如果不出错会编译通过。如下图 4.42 所示： 

 
图 4.42 保存并编译 
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4.3 下载组态 

1） 设置 PG/PC 接口 

注意：为了顺利下载配置，在不知道控制器当前下载参数的情况下先用 MPI 接口下载，方法如下： 

a) 将与控制器连接的 DP 连接头与 X1MPI 口连接。打开控制面板，能看见一个新图标，设置 PG/PC 

接口 。 

b) 双击图标打开这个配置工具，在应用程序访问点位置，选择“S7ONLINE （STEP7）

CPXXXX(MPI)”。在“为使用的接口分配参数”位置选择“CPXXXX（MPI）”，如下图 4.43 所示： 

 
图 4.43 设置 PG/PC 接口 

c) 点击“属性”按钮，在属性窗口中，勾选“PG/PC 是总线上的唯一主站”，点击“确定”按钮，如

下图 4.44 所示： 

 
图 4.44 MPI 属性设置 
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d) 选择 CP5611（MPI）并点击“激活”按钮，完成配置，如下图 4.45 所示： 

 
图 4.45 激活 MPI 模式 

注：CPXXXX，根据实际情况来选择 CP5611 或者 CP5512。图片中均以 CP5611 为例。 

2） 下载 

a) 确保控制器在“RUN-P”模式下。在硬件配置窗口下点击“Download to Module” 按钮，将

当前硬件组态下载到控制器中。按照提示一直选择 OK 或 YES，如下图 4.46 所示： 

 
图 4.46 程序下载 

b) 在工程窗口下，选择“SIMATIC 300(1)”，再点击“Download” 按钮。按照提示一直选择 OK

或 YES，如下图 4.47 所示： 

 
图 4.47 下载硬件组态 
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c) 下载结束后将与控制器连接的 DP 连接头切换到 X2 DP 口，然后将模块 S1.8 拨码开关位拨到 OFF

状态，进入正常工作模式，可以看到 LED1 变灭，说明 PROFIBUS DP 网络已经上线；同时配置

底板上的 TXD 会闪烁，说明 Modbus 端循环命令发送已启动。 

3） 重新设置 PG/PC 接口 

a) 打开控制面板，可以看见一个新图标，设置 PG/PC 接口 。 

双击图标打开这个配置工具，在应用程序访问点位置，选择“ S7ONLINE （ STEP7 ）

CPXXXX(PROFIBUS)”。在“为使用的接口分配参数”位置选择“CPXXXX（PROFIBUS）”，如下图 4.48

所示： 

 
图 4.48 设置 PG/PC 接口 

b) 点击“属性”按钮，在属性窗口中，勾选“PG/PC 是总线上的唯一主站”。“传输率”的设置根据

协议不同而不同，测 DP 设备，传输率设置为 1.5Mbps（DP 设备可配置多种，1.5Mbps 仅为推

荐值，可根据实际工程修改，本实例设置为 1.5Mbps，范围：9.6kbps~12Mbps，不包括 45.45kbps），

配置文件选择 DP。点击“确定”按钮，如下图 4.49 所示： 
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图 4.49 设置 PROFIBUS 属性 

c) 选择 CP5611（PROFIBUS）并点击“激活”按钮，完成配置，如下图 4.50 所示： 

 
图 4.50 激活 PROFIBUS 模式 

注意：下次在不改变总线网络传输速率的情况下就可以直接点击下载按钮再次下载新配置。
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第5章 系统调试 

5.1 启动 Modbus Slave 模拟软件 

到目前为止，PROFIBUS DP 网络已经建立，Modbus 端 M0306 模块作为主站也已经开始循环向用户

板发送用户配置的 Modbus 命令，只是用户 Modbus 从站还没有数据响应，接下来启动 Modbus Slave 软

件模拟用户 Modbus 从站设备来响应 M0306 模块的 Modbus 命令请求，步骤如下： 

1) 打开电脑中已经安装好的 Modbus Slave 模拟软件，软件界面如下图 5.1 所示： 

 
图 5.1 打开 Modbus Slave 软件 

2) 点击“File”菜单，选择“New”，弹出 Modbus 模拟从站窗口，如下图 5.2 所示： 

 
图 5.2 新建从站 
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3) 在弹出的窗口空白处单击右键，选择“Slave Definition”，弹出 Slave Definition 对话框，如下图 5.3 所

示： 

 
图 5.3 从站属性对话框 

4) 根据配置的 Modbus 循环命令参数设置 Modbus Slave 参数，如下图 5.4 所示： 

 
图 5.4 设置从站参数 

5) 点击 OK 按钮，则一个模拟从站就建立好了，如下图 5.5 所示： 

 
图 5.5 Modbus 模拟从站 
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6) 点击菜单栏中的“Connection”，选择“Connect”，弹出网络连接对话框，如下图 5.6 所示： 

 
图 5.6 网络连接对话框 

7) 根据用户设置的 Modbus 串口通信参数配置串口通信参数，如下图 5.7： 

 
图 5.7 设置串口通信参数 

8) 点击OK按钮，可以看到M0306模块上的LED2变亮，同时配置底板上的RXD也开始闪烁，说明Modbus

数据传输已启动，到此，整个测试实例环境就搭建好并且正常工作起来了。 

5.2 上线监视 

1) 回到 Step7 软件的硬件组态界面，单击 M0306 模块图标 ，可以在界面下方的菜单栏中看到

M0306 模块中的功能块信息，如下图 5.8 所示： 

 
图 5.8 M0306 功能块 

2) 在 8DI 栏上右键，选择“Monitor/Modify”弹出该功能块在线监视界面，如下图所示： 
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图 5.9 模块监视窗口 

3) 勾选左下角栏目中的 ，开始在线监视，如下图所示： 

 
图 5.10 在线监视 

5.3 调试通信 

1) 改变 Modbus Slave 模拟软件中 01 功能码从站中的地址 1~8 的线圈状态，可以看到状态信息在 8DI 监

视界面中的对应位同步显示，如下图所示： 
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图 5.11 监视数据同步 

至此，M0306 模块的整个配置使用实例就完成了。 
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